
Web Public Search


The Web Public Search (also called WebOPAC) is a function for publishing your catalogue 
online. The library readers may query your catalogue, check the titles availability, reserve 
titles, check their account, renew their current loans, modify their address etc. On your side, 
you can get the statistics of the queries sent by your readers.


This document describes how to set up the web public search, how your readers can use it 
and the different kinds of statistics you can get.
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1.	 Operation principle

The WebOPAC server is a function of the BiblioMaker system that lets a library publish its 
catalogue on the web. Remote users can query the catalogue using their web browser.


The WebOPAC server functions in the following manner : processes are running on the 
server, waiting for requests. When a request using the HTTP protocol is received, it is 
analysed and handled : a search is performed in the database. The search result (a list of 
records) is sent back to the remote user as a HTML file.


The WebOPAC server is completely integrated in the BiblioMaker system and uses no 
external CGI executable. Therefore, it does not need any further application such as Internet 
Information Services (IIS) from Microsoft or Apache.


1.1	 Single-user architecture


With a single-user version of BiblioMaker, the workstation is the web server. The WebOPAC 
server runs in the background while the user catalogues, searches records, prints lists or 
registers loans.


The constraint of this architecture is the need for the BiblioMaker application to run, 
otherwise the web server will not respond to requests. This is why the user shall not quit 
the program or turn his computer off.


If you don’t want to transform your workstation in web server, you have the choice 
between two options :


• Install a copy of the program and of the data file on a web server. You will then have to 
copy regularly the data file from the workstation (or from a file server) to the web server.


• Use the client-server version of BiblioMaker to configure the BiblioMaker server as a web 
server. In this case, the workstation is not used as a web server.


N.B.: Using a client-server version of BiblioMaker implies a modification of its licences. 
Please contact Micro Consulting in order to get further information about this topic.


You will find information about setting up the WebOPAC server in the chapter called 
Setting up the WebOPAC.
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1.2	 Client-server architecture


In multi-users mode, BiblioMaker uses the client-server architecture; it means that two 
applications are used : BiblioMaker Server on the server and BiblioMaker Client on the 
workstations. The data file is obviously hosted by the server.


With this architecture, the WebOPAC server can be hosted either by a client computer (1st 
option) or by the server (2nd option).


1st Option





2nd Option




The second option gives the quickest response time, as all operations (reception of the 
queries, search in the database, answers send back) are performed on the same computer. 
Nevertheless, with the first option you can set up several WebOPAC servers concurrently, all 
of which will query the same database (load balancing). Another advantage of the first 
solution : you can protect your BiblioMaker server by putting it into a secured network 
zone and the WebOPAC server could be placed into a DMZ.


BiblioMaker in the Cloud uses the second option. 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1.2.1.	WebOPAC server on a client computer (1st option)


If you have decided to use a client computer as an WebOPAC server, you can set it up with 
the BiblioMaker Client application that must be installed on this computer.


The WebOPAC server uses pages in the HTML-format delivered with the single-user version 
of BiblioMaker. These pages contain forms and templates for displaying the found records. 
Therefore, you must copy on the computer used as a web server the folder called 
OPAC_Web you will find in the folder containing the BiblioMaker application on the 
BiblioMaker server. The exact path of the OPAC_Web folder on the WebOPAC computer’s 
hard disk is not relevant.


Please read the chapter Setting up the WebOPAC if you need further information about the 
options of the WebOPAC server.


The client computer and the BiblioMaker server communicate using the TCP ports 19812, 
19813 and 19814 by default. If a firewall protects your server, do not forget to open these 
ports.


The computer used as an WebOPAC server can be used also as a normal workstation (the 
WebOPAC server runs in the background). But the BiblioMaker Client application must be 
running for the WebOPAC server to answer the queries. This is why you should inform the 
users of this computer that they shall not quit BiblioMaker Client.


1.2.2	 WebOPAC server on the BiblioMaker server (2nd option)


Because of technical constraints, BiblioMaker Server does not contain a user interface for 
setting up the WebOPAC server. The server could be theoretically be set up from a client 
computer. Nevertheless, some options (for instance, the IP address of the WebOPAC server 
and the path to the homepage) depend on the WebOPAC server’s configuration. This is 
why we recommend to define the parameters of the WebOPAC server with the BiblioMaker 
Client program installed on the server.


With BiblioMaker in the Cloud, the WebOPAC server basic settings are set up by Micro 
Consulting.


Please read the chapter Setting up the WebOPAC if you need further information about the 
options of the WebOPAC server.
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2.	 Setting up the WebOPAC

You set up the WebOPAC server with the BiblioMaker (Client) application. If the WebOPAC 
server is hosted by the BiblioMaker server, please use BiblioMaker Client installed on the 
web server. If the web server will be hosted by a client computer, you have to connect to 
the BiblioMaker server with BiblioMaker Client from the future WebOPAC server.


You set up the WebOPAC by calling the Configure the web public search command in the 
Other menu of the Maintenance. If several user accounts have been defined in the 
BiblioMaker application, only the Administrator will be allowed to access the configuration 
dialog.





The Execution column is not displayed with the single-user version of BiblioMaker.


You can define several configurations for the WebOPAC (for instance one configuration for 
a WebOPAC server located inside your local area network and another configuration for a 
WebOPAC server located at an Internet service provider who publishes your catalogue on 
the web). This is why a dialog box displays the several defined configurations. If you want 
to create a new configuration, click on the Add button (or on Duplicate if you want to 
keep the settings of another existing configuration).


As there are many parameters for the WebOPAC, the configuration dialog is divided in 
several pages.


With BiblioMaker in the Cloud, only tabs containing settings for librarians are displayed. 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2.1	 Web server tab (not available in the cloud version)





Configuration : configuration’s name. Each configuration must have a unique name.


Automatic startup of the server : check this box if you want the web server to start during 
the software startup.


Web server running on a client computer : check this box if the integrated web server 
must run on a client computer and not on the BiblioMaker server.


IP address : enter the IP number or the computer name which the web server must run on.


TCP port number : define the web service’s port number. Standard ports art 80 and 8080. 
On the Mac, the 80 port number is usually reserved. Caution, don’t define a port number 
already on use by another service on the same computer.


Number of processes : usually 4 is enough. If you expect to receive many simultaneous 
queries, you may define a value greater than 10.


Size in bytes : size of each process in random access memory. By default, 128’000 are 
enough.


Main folder and Home Page : homepage’s path. The homepage is a HTML file located on 
the web server’s hard disk. Use the Path… button in order to select the file. By default, the 
main folder (folder called OPAC_Web) is located inside the folder containing BiblioMaker’s 
single-user version. The homepage is located inside this folder, in a subfolder called 
Template, then in another subfolder sporting the interface language name (for instance 
English) and its name is Main.htm.


Activities log : tick this box only temporarily, if you have problems with the web server.
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Queries log : tick this box if you want the program to save each received query in order to 
get statistics about the use of the online catalogue.


Auto. delete after x days : define here how long the period of time before statistics must 
be deleted. The 0 value means no statistics record is deleted.
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2.2	 Authorisations tab





This page of the parameters lets you define which services you offer to the library users.


Libraries that do not wish to make their online catalog available to everyone, but only to 
their registered readers, may check the Private Access box: readers will have to identify 
themselves to access the online catalog. In this case, it is strongly recommended to check 
the Mandatory Password box to prevent any abuse of the connection.


Define with the Period of validity of a session the time before the reader's login and 
password are requested again. This can range from a few minutes to 365 days. 24 hours is a 
good compromise between security and convenience.
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2.3	 General tab





Orders can be seen : current orders may be displayed in search results (this check box has 
a meaning only with the acquisitions module of BiblioMaker PRO)


Relation “And/Or” (subjects) : if this check box is ticked, a pop-up menu containing the 
And/Or boolean relationship is displayed in the search form by subject. This menu is only 
useful if you work with subjects composed of main subjects and secondary subjects (such 
as for instance “Great Britain : History : 20th Century”).


Dialog “And/Or” (subjects->titles) : if this check box is ticked, radio buttons are displayed 
under the list of found subjects. These radio buttons let you combine several selected 
subjects for searching for corresponding titles.


Display the borrower name : displays the borrower name in the availability section of a 
lent title.


Display the date of return : displays the date of return in the availability section of a lent 
title.


Display the thesaurus search : if this check box is ticked, an additional link called Display 
the list of subject categories is displayed in the search form by subject (this check box is 
displayed only if you have the Thesaurus module).


Display title cover picture : A picture of the title cover is displayed. This picture comes 
from the COVER PICTURE field in the Titles file.


Search the picture automatically on the internet : if the title record does not contain the 
cover picture, the picture is searched on the web. But the search happens only if the title’s 
ISBN has been saved in the title record.
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Simple Search and by Title /  Keywords : specify how the application should behave when 
searching.


Administrator of the server : enter the name and the e-mail address of the librarian the 
readers may contact. The name and the e-mail are displayed on the homepage.


E-mail sender : choose here an e-mail sender account. These accounts are defined with the 
Configure sending e-mails command in the Other menu of the Maintenance.


If you’d like to be informed by e-mail when a reader reserves a title, changes his post 
address or registers to the library, you must define this parameter.


User : choose here one of the BiblioMaker user accounts. These accounts are defined with 
the Users command in the Maintenance menu of the Maintenance.


The account you choose here is saved in changed Address or Loan records. You access the 
last modification’s author with the Info button of the corresponding records. This can be 
useful if you need to understand who modified a record and when.


This is why we suggest that you create a user called for instance “WebOPAC server”. If you 
uncheck the Active check box, this user account will not be displayed in the login dialog.


New acquisitions : define here the period of time for a new acquisition to be considered as 
such. This delay is used as a parameter when searching for new acquisitions in the 
WebOPAC and in the virtual showcase (read on).


Display showcase : if you tick this box, a virtual showcase is displayed on the online 
catalogue homepage. The showcase contains either new acquisitions, or titles you have 
selected. Please note that only titles with a cover picture are displayed in the showcase.


Activate Antolin : by ticking this box, you can link your catalogue with the german Antolin 
website. Antolin contains thousands of books for children.
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2.4	 LDAP tab (not available in the cloud version)





Authentication with a LDAP server : if you tick this check box, BiblioMaker will 
communicate with a server using the Lightweight Directory Access Protocol. This kind of 
directory is used for managing users and authorisations in a centralised manner.


When a reader wants to query his/her account or reserve a title, he/she must give his/her 
identity (reader code) and a password. BiblioMaker transmits the code and the password to 
the LDAP server. The LDAP accepts or refuses the password. If the password is invalid, the 
reader must enter the password again.


If the password is valid, BiblioMaker saves it in the reader’s record. So, if the LDAP is 
temporarily unavailable, BiblioMaker will use the saved password in order to authenticate 
the reader.


The parameters of the LDAP server are :


IP address : LDAP server’s address (the 389 port number is implicit; if the LDAP server uses 
another port number, enter it after the colon sign following the IP address; example : 
192.168.3.23:390).


Query : query syntax used to query the LDAP server. The query must contain the <uid> 
code that will be replaced by the reader’s ID* signing in the WebOPAC.


*the reader’s ID is either the LDAP IDENTIFIER field contents (if this field has been filled out) 
or the reader CODE field contents.


Syntax example : sAMAccountName=<uid>,cn=users,dc=?,dc=ch
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2.5	 Security tab (not available in the cloud version)





When a reader logs in in the web public search (in order to book a title or to query his 
account), he enters his reader code and password. When querying his account, the web 
server transmits personal information such as the list of lent titles, the private address etc.


These information can be encrypted using the SSL protocol (Secure Socket Layer). SSL 
needs a digital certificate authenticating the BiblioMaker web server. With the Security tab, 
you can generate a certificate order and register the certificate delivered by the authority 
you have chosen.


Activate secure connections (https) : tick this check box if you want to secure the 
connections in the web OPAC.


Notice : this box can be ticked only if all obligatory parameters in this tab have been 
defined.


Secure TCP port number : enter the TCP port number to use for secure connections. 
Usually, it is the port 443. But if the server Web OPAC runs under Mac OS X, only port 
numbers greater than 1024 can be used. We suggest that you choose the 8443 port 
number, but check first that this port is not already in use.


4D port number : enter the TCP port number for insecure connections. As this field has 
been created mainly for test purpose, it is safer to leave this field empty.


Number of processes : number of processes answering to queries. If you think that the 
web server will not receive more than several hundreds queries a day, you may define a 
value of 4 processes.
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Secure domain : domain name encoded in the certificate. The Web OPAC server must 
belong to the domain name. If the server has a subdomain name, enter here the 
subdomain name followed by the domain name (for instance opac.library.ch). You can also 
enter an IP address, but some certification authorities (such as QualitySSL) demand a 
domain name.


With the  icon, you can query the www.uwhois.com web site and display in a web 
browser the Whois information about the entered domain name.


Company : library or institution name having reserved the domain name.


Department : library/institution department.


Place : library/institution’s place.


Canton : library/institution’s canton.


Country : library/institution’s country. Enter here a code of two characters, following the 
ISO-3166 standard (http://www.iso.org/iso/country_codes.htm). For instance, the country 
code for Switzerland is CH.


Secure e-mail address : e-mail address for the contact person registering the domain 
name. Caution, some certification authorities (such as QualitySSL) demand  the e-mail 
address to contain the registered domain name.


Certificate order : after all fields have been filled up, click on the Generate button. The 
button’s name turns to Display. Click on the Display button and copy the text that has 
been generated. This text must be pasted into the online form on the certification 
authority’s web site.


Private key : a certificate contains a private key. This key is generated automatically with 
the certificate order. But you may also generate a key with another software. In this case, 
click on the Enter… button and paste the key.


Public key : a certificate contains a public key. This key is generated automatically with the 
certificate order. But you may also generate a key with another software. In this case, click 
on the Enter… button and paste the key.


Certificate : after you have received the certificate from the authority, copy it, click on the 
Display button and paste it. If a certificate has been registered, its creation date and time 
are displayed next to the Display button.


Certificate signed by : pop-up menu containing the main certification authorities. After 

you have selected the authority, click on the  icon in order to connect to its web site, 
on which you may send your certificate order.


Validity : enter the certificate validity date. Indeed, a certificate validity is limited in time. 
When starting the Web OPAC server in secure mode, BiblioMaker displays an alert when 
the validity date is nearly reached.


When the Web OPAC server starts up the secure connections for the first time, it creates 
two files on the disk : key.pem (containing the private key) and cert.pem (containing the 
certificate). These files are saved in the same folder as the BiblioMaker application (single-
user or server version).


This means that the folder containing the application may not be read-only.
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2.6	 E-mails tab





When a reader performs some operations in the online catalogue (for instance applies to 
the library, reserves a title or cancels a reservation), an e-mail can be sent to the librarians 
in order to inform them.


You can edit the e-mail title or message. If you tick the Do not send this message check 
box, no e-mail will be sent for the corresponding operation.


Notice : It is necessary to set up BiblioMaker in order to send e-mails by using the 
Other>Configure sending e-mails in the Maintenance. Once the e-mail settings have 
been defined, you can choose the e-mail account with the E-mail sender pop-up menu in 
the Webserver tab of the WebOPAC parameters.
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2.7	 Info picture tab





Register in the last tab a picture giving information about the library. This picture is 
displayed in the web public search when a reader clicks on the Information about the 
library link on the homepage.


Insert the picture in this dialog either with the Copy and Paste function, or the Select 
button.


The online map’s URL is a link to an online map that lets remote users using their mobile 
device locate the library. You fill up this field by visiting such an online map web site (for 
instance Google Maps), by displaying the library location, then by copying and pasting the 
map URL to this field.


The library phone number is displayed in the interface for mobile devices as a link or a 
button : by clicking on it, the remote user can directly call the library.


2.8	 Starting / Stopping the WebOPAC server


You manually start or stop the WebOPAC server from the dialog box listing the server 
configurations : select the configuration, then click on the Start / Stop button.


With the multi-user version of BiblioMaker, if the WebOPAC server is hosted on the 
BiblioMaker server, you can start/stop the web server from any client computer. If the 
WebOPAC server is hosted on a client computer, only this computer can start/stop the web 
server.


If you modify some web server settings, these new settings will be taken into account only 
after a restart of the web server.
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2.9	 Setting up readers’ accounts


If you’d like your readers to be able to query their account and to reserve titles, you must 
give them a password they will enter in the WebOPAC in order to authenticate.


Use the Action>Apply>Password loans command in the Addresses file in order to define a 
password. You can give password in three manners :


• Apply a value : the same password will be applied to all selected readers. 
Communicating the password to the readers is easy. But it is not very secure, as readers 
could quickly realise that their password is the same as their neighbours’...


• Apply the reader code : the system gives to each reader his code as password. When a 
reader connects to his account for the first time, the system demands that he changes 
his password. This method is more secure than the first one and communicating the 
password to the readers is quite simple.


• Apply a random value : the system gives any password to each reader. This method is 
the safest one, but you need to communicate the password in writing (letter or e-mail) 
with the Password letter available in the Print dialog of the Addresses file.
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3.	 Using the WebOPAC

The online catalogue can be browsed either from a computer or a tablet, or from a mobile 
device with a small screen (such as a smartphone). The user interface is optimized for each 
screen size, but on smartphones, there are less options than on a computer.


3.1	 Query the catalogue


Readers query the catalogue by connecting to the homepage using a web browser.


On the homepage, they can either enter some words in the «Easy search» field, or click on a 
link in order to do a specialised search (by keyword, author, subject, series, etc.). After they 
have filled up the form, they get a list of records corresponding to their criteria.


In the list of found titles, a click on a title displays the complete title record with its 
availability.


3.2	 Registration of a new reader


A link called Sign up to the library is displayed on the catalog’s home page. When one 
clicks on this link, a registration form is displayed. After he has filled out the form, the 
reader clicks on the Send button.


The form is sent by e-mail to the librarian who decides to accept or refuse the registration. 
For security reasons, the address data file is not modified by the registration.


You can configure the registration form, in order to choose which fields must be displayed 
and which ones are obligatory. You need an HTML editor and some basic knowledge of the 
Javascript programming language. The registration form is a file called Register.htm located 
in the OPAC_Web/Template/[Language]/ folder.


Caution : do not edit the original file, but copy it and put the copy into the OPAC_Web/
[Language]/ folder. Edit only the copy. The copy must sport the same name as the original 
file.


3.3	 Query an account


A link called My account is displayed on the catalog’s home page. When one clicks on this 
link, a login dialog is displayed. The reader must enter his code and his password, then click 
on the Sign in button.


If the reader has forgotten his code or password, he can get it by e-mail using the e-mail 
address registered by the library.


After a successful login, the web public search displays the reader’s post address and the 
list of current loans and reservations.


If the readers have the corresponding authorisation, they may change their post address 
(link Edit address), change their authentication password (link Edit password) and display 
their past loans (link Display past loans).


3.3.1	 Changing the post address


Changing the post address is done with a form containing the current address. The reader 
edits the fields and validates the changes with the Send button. The reader record is 
immediately updated in the database’s Addresses file and an e-mail is sent to the librarian.


You can configure the form for updating the post address in order to choose which fields 
must be displayed and which ones may be edited. You need a HTML editor. The form is a 
file called PageAddr.htm located in the OPAC_Web/Template/[Language]/ folder.
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Caution : do not edit the original file, but copy it and put the copy into the OPAC_Web/
[Language]/ folder. Edit only the copy. The copy must sport the same name as the original 
file.


3.3.2	 Changing the password


Changing the password is done with a form containing three fields : the field for entering 
the current password and two fields for entering the new password. The reader validates 
the change with the Send button. The reader record in the database’s Addresses file is 
immediately updated and an e-mail send to the librarian.


You can configure with a HTML editor the form for updating the password. The form is a file 
called ChangePassword.htm located in the OPAC_Web/Template/[Language]/ folder.


Caution : do not edit the original file, but copy it and put the copy into the OPAC_Web/
[Language]/ folder. Edit only the copy. The copy must sport the same name as the original 
file.


3.3.3	 Displaying past loans


The past loans display a list of title lent by the reader, sorted chronologically.


You can configure the list format with an HTML editor. The list is a file called ListStat.html 
located in the OPAC_Web/Template/[Language]/ folder.


Caution : do not edit the original file, but copy it and put the copy into the OPAC_Web/
[Language]/ folder. Edit only the copy. The copy must sport the same name as the original 
file.


3.3.4	 Renewing loans or canceling reservations


If the corresponding authorisations have been given and if all conditions are met, the 
reader may renew a current loan or cancel a reservation. A check box Renew/Cancel is 
displayed next to each current loan/reservation.


When a reader renews a loan or cancels a reservation, the database’s Loans file is 
immediately updated and an e-mail is sent to the librarian.


You can configure with a HTML editor the web page displaying the reader account. The 
page is a file called ListLoan.htm located in the OPAC_Web/Template/[Language]/ folder.


Caution : do not edit the original file, but copy it and put the copy into the OPAC_Web/
[Language]/ folder. Edit only the copy. The copy must sport the same name as the original 
file.


3.4	 Title reservation


A reader reserves a title from the online catalogue. In the detailed view of a title record, 
alongside the title’s availability, a link called Reserve this title is displayed. This link opens a 
reservation page : the reader must enter his code and his password in order to reserve the 
title.


If the library’s policy is to send titles to readers’ home, two additional radio buttons are 
displayed in the reservation dialog box : I will fetch the title at the library when available 
and Please send me the title when available. The chosen option appears on the e-mail 
sent to the librarian.


A reservation creates a reservation record in the Loans file and an e-mail is sent to the 
librarian.
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You can configure with a HTML editor the web page displaying the reader account. The 
page is a file called ReserveTitle.htm located in the OPAC_Web/Template/[Language]/ folder.


Caution : do not edit the original file, but copy it and put the copy into the OPAC_Web/
[Language]/ folder. Edit only the copy. The copy must sport the same name as the original 
file.
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4.	 Statistics about the WebOPAC

With BiblioMaker, you are able to get much many information about the use of the 
WebOPAC. Indeed, the system can register each  query received and print statistics about 
them.


4.1	 Setup of the WebOPAC


You setup the WebOPAC by calling the Configure the web public search in the Other 
menu of the Maintenance, either in the single-user of BiblioMaker or on a client computer 
with BiblioMaker Client.


Among the many options you will find in the Web server tab a check box called Query log. 
This box must be ticked if you want the program to register the queries.


4.2	 Statistics on the use of the WebOPAC


Each query is automatically saved in a file called Statistics WebOPAC. You reach this file with 
the Statistics WebOPAC command in the Data menu.


A statistics record contains the following information :


• Date and time of the query


• Query type (easy search, search by title, by author, by class mark, by subject, by series or 
by several criteria)


• Search criteria entered by the reader


• Number of found records


With the Find command, search queries using the criterion of the date, time, number of 
found records or query type. If you only need to know how many queries have been 
received during a certain lapse of time, enter the dates in the Find dialog and start the 
query.


If you need more detailed statistics, several list and export formats are available:


4.2.1	 Print templates


List of search criteria


List containing the date and time of each query and the search criteria defined by the 
reader. This list is useful if you want to analyse the criteria and the syntax used by the 
reader. The list could show that some readers don’t use the right syntax (for instance with 
the search by author, by typing the name before the surname). If necessary, train the 
readers.


Another example is to search for queries by subject that have led to zero found record. 
Print a list of these queries and compare the typed words with your own subjects directory. 
If you should notice that some words are often used by readers, but that they miss in your 
directory because you use a synonym, you could add this word to the directory and refer it 
to another subject record.


Number of queries by date


Print template containing the number of queries received during a certain lapse of time. 
Numbers are summed up by hour, day, week, month or year. You get a list and a chart.
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Number of queries by type


Print template containing the number of queries received, distributed by search type (easy 
search, by keyword, by author, by series, by class mark, by subject or by several criteria). 
You get a list and a chart.


4.2.2	 Export templates


Simple


This template exports into a text file each selected query with all details (date and time, 
query type, number of found records, search criteria). Open this text file with a spreadsheet 
program and use the search and sort functions in the spreadsheet in order to analyse the 
queries.
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5.	 Customizing the WebOPAC’s user interface

The WebOPAC is delivered in a fully functional way and can be started right after some 
basic parameters have been defined. But some libraries would like to customize the online 
catalogue, for instance in order to accomodate it to their main website or to change some 
objects (library’s logo, explanation to the readers, etc.).


BiblioMaker WebOPAC’s server uses templates saved in a folder called «OPAC_Web» 
located in the folder containing BiblioMaker’s single-user version. You can modify these 
templates if you need to.


One should not underestimate the difficulty of customizing the HTML pages. A HTML text 
editor is necessary as well as knowledge of the HTML codification, cascading stylesheet 
and the structure of the files installed on the server. In fact each page contains links to 
other pages as well as codes for the server. If one page is modified there is a risk that links 
may be broken or that needed codes are erased, which could lead to an unusable 
WebOPAC. In view of this, the customization of HTML pages should only be done by 
experienced persons who can devote several hours to the job.


This document does not explain in all details how to customize your online catalogue 
(please read the handbook for that), but it describes a minimal customization, such as 
displaying your own logo and the library’s name and address in the header, the 
information about your library and it explains how to edit the stylesheet in order to change 
the frames colour.


5.1	 Minimal customization


5.1.1	 Library’s logo


By default, the online catalogue displays the BiblioMaker logo on the header. You can 
replace it with your own logo.


The logo must be saved in a GIF file named Logo.gif. This file must be placed on the 
computer used as the WebOPAC server, in the OPAC_Web/Common/ folder. Usually, the 
OPAC_Web folder is found under :


Windows : C:\Program files(x86)/BiblioMaker[version number]/


Mac OS : Macintosh HD:Applications:BiblioMaker:


5.1.2	 Library’s name and address


The library’s name and address can be displayed in the header near the logo.


The name and address must be entered directly in the BiblioMaker database : call the 
File>Maintenance, then the Maintenance>Configuration commands. Fill out the 
Library and Heading fields.


5.1.3	 Information about the library


There are several ways to display information about the library. We will explain only the 
easiest one, so that the link called Information about the library on the home page 
displays this information.


In a word processor or graphics painting software program, write the information (opening 
time, number of books you have, etc.). You can naturally add some pictures.
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After you have defined the layout for this information, grab a copy of the screen part 
containing the information. Under Windows, use the Snipping tool. Under Mac OS, press 
the Command-Control-Shift-4 keys.


In BiblioMaker, display the parameters of the WebOPAC server (command 
File>Maintenance, then Other>Configure the web public search, then change the 
existing configuration). In the Info Picture tab, paste the picture you have copied.


5.1.4	 Frames colour


The properties of frames and of other objects are saved in a stylesheet file called 
Stylesheet.css located inside the OPAC_Web/Template/Common/ folder. Usually, the 
OPAC_Web folder is located under :


Windows : C:\Program files(x86)/BiblioMaker[version number]/


Mac OS : Macintosh HD:Applications:BiblioMaker:


Do not edit the original Stylesheet.css file, but copy it to the OPAC_Web/Common/ folder 
and edit the copy.


The stylesheet contains about 40 styles. The frames colour is defined in the following styles 
:


.ExplanationZoneBorderColor


.FindZoneBorderColor


.InfoZoneBorderColor


.MainZoneBorderColor


Replace the colour codes with the code of another colour. If you don’t know the colour 
code, you will find on several websites utilities for converting a colour to its code.
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